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INTR“D“CT"’N * Training mode with Beeper feedback for users to practice their trigger speed without the
) : ) . ) i need for air and paintballs
Empire Paintball has created the finest paintball marker in the proud history of Empire prod- « User adjustable Anti-Bolt Stick settings makes first shot drop off a thing of the past
ucts. The Var]qqish is the pinnacle of intelligent marker design incorporating cutting edge * Preset tournament firing modes to keep you legal at all major tournament series
technology within a proven marker platform. * Customizable ramping and full-auto modes to max out your markers performance
¢ Resettable shot counter

Hardware Features * Screen display of calculated Average and Peak ROF’s
* Pressure balanced Spool Valve firing engine
¢ Super Freak 7pc barrel kit with Carbon Fiber tip and five bore sizes (.675, .680, .685, Empire Vanquish SDGCifIGatiOIIS

690, '695)_ o e Model: Empire Vanquish
* 5 way IOYSt'CK navigation contro! . _ * Barrel: 14 inch ported, three-piece Carbon/Aluminum Super Freak
¢ Super bright 2000:1 contrast ratio 1” OLED Display, White on Black background « Caliber: .68
e Built in temperature compensated precision Pressure Transducer for on screen pressure « Action: Electro-pneumatic

read-out. No bulky external gauges or special pressure tester kit needed « Air Source: Compressed Air or Nitrogen (NoCO,)
* Blue Laser Breech S.ensor System * Battery: One 9-Volt (Alkaline Only) 2
* Low force trigger switch ] * Main Body Material: Aerospace 6061 Aluminum
e 2.7KHz Beeper to provide audio feedback « Weight: 25 ounces
¢ Nano Watt XLP Flash microcontroller performing up to 16 MIPS (million instructions per

second) provides highly accurate timing while not eating your battery INCLUDED WITH YOUR EMPIRE VANQUISH:
* Single tool for all maintenance « 14” Super Freak Barrel (14” Carbon Tip, Aluminum Back, 5 Inserts - .675, .680, .685, .690,
e Quick strip bolt .695)
* Gasthrough grip frame * Neoprene Marker Carry Case
¢ Ambidextrous feedneck with adjustment « 3/32” Hex Wrenches - Driver Handle, L-shaped
¢ ON/OFF ASA with Regulator o Lubricant
e Quick strip trigger « Empire Barrel Bag

e Empire Headband

Software Features * Bottle Opener/Key Chain
¢ “Slick Assistant” lubricant monitoring system alerts you when you need to lube you gun * Empire Stickers
* 4C Eye compatible out of the box * One 9-Volt Alkaline Battery
* USB to PC enabled out of the box with no special accessories needed. Upgrade firmware, * Quick Start Manual

change settings, and make custom boot screens with the included PC software * Full Digital Manual on CD
* RF Upgradeable for seamless marker to loader communication * USB Cable

¢ [nterrupt based firmware gives an ultra responsive feel when firing. Virtually no lag time
between trigger pull and response time

¢ Super intuitive menu system that makes changing settings quick and easy

¢ 3 Customizable User Configurations to quickly and easily switch your style of play in
seconds

——— www.empirepaintball.com
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w ARNING | PAINTBALL GUNS AND PAINTBALL GUN
= ACCESSORIES ARE NOT TOYS!
- Careless use or misuse may result in serious bodily injury or death!
- Eye protection designed for paintball must be worn by the user and all persons within range.
- Not for sale to persons under 18 years of age.
- Must be 18 years of age or older to operate or handle any paintball gun and paintball gun accessories without adult or parental supervision.
- Read and understand all cautions, warnings, and operating manuals before using any paintball gun or paintball gun accessory.
- Do not aim paintball gun at eyes or head of people or at animals.
- Paintball guns are to be used with Paintballs only.
- To prevent fire or shock hazard, do not expose unit to rain or moisture.
- To prevent fire or shock hazard, do not immerse unit in liquids.
- To prevent fire or shock hazard, do not disassemble any electronic paintball device.
- The disposal of the battery used to power this product may be regulated in your area.
- Please conform to all local or state regulations with regard to battery disposal.
- Use common sense and have fun.

Any tampering with the unit voids your warranty. There are no consumer serviceable parts inside the unit. The use of non factory authorized
components within this product may cause a critical failure, fire or shock hazard.

IN NO EVENT SHALL SELLER BE LIABLE FOR ANY DIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR LOSSES OR
EXPENSES RESULTING FROM ANY DEFECTIVE PRODUCT OR THE USE OF ANY PRODUCT.

WARNING: This product contains one or more chemicals that are known to the State of California to cause cancer and birth defects or other
reproductive harm. Wash hands after handfing. You must be at least 18 years of age to purchase this product. This product may be mistaken for
a firearm by law enforcement officers or others. Altering the color of the product or brandishing the product in public may be considered a crime.

Rules For Safe Marker Handling

IMPORTANT: Never carry your Empire Vanquish uncased when not on a playing field. The
non-paintball public and law enforcement personnel may not be able to distinguish between
a paintball marker and a firearm. For your own safety and for those in the area and to protect
the image of the sport, always carry your Empire Vanquish in the marker case or a suitable
container.

Safety and safe marker handling are the most important aspects of paintball sports. Please
practice each of the following steps with an unloaded marker before attempting to operate
your marker with an air source and paintballs. Read this entire manual before loading, or
installing an air cylinder, or in any way attempting to operate the marker.

*READ OWNER’S MANUAL BEFORE USING*

e This is not a toy, use with caution.

* Treat every marker as if it were loaded.

¢ Never look down the barrel of a paintball marker.

¢ Keep your finger off the trigger until ready to shoot.

¢ Never point the marker at anything you don’t wish to shoot, including fragile objects such

as windows.

e Keep the marker turned off until ready to shoot.

* Keep the barrel-blocking device in/on the marker’s barrel when not shooting.

e Always remove paintballs and the air source before disassembly.

o After removing air source, point marker in safe direction and discharge until marker is
confirmed as degassed.

e Store the marker unloaded and degassed in a secure place.

¢ Follow warnings listed on the air source for handling and storage

¢ Every person within range must wear eye, face, and ear protection designed specifically to
stop paintballs and meeting ASTM standard F1776.

¢ Always measure your marker’s velocity before playing paintball and never shoot at veloci
ties in excess of 300 feet-per-second (91.44 meters).

¢ Remember that the ultimate safety device is you, the operator.

For manuals in other languages and warranty details, go to: paintballsolutions.com

www.empirepaintball.com
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QUICK SETUP

Empire Super Freak Barrel

The Empire Super Freak Barrel is included with the Empire Vanquish marker. The Super
Freak is a three-piece barrel that consists of a front section (tip), a back section (back) and
five sized, aluminum inserts. The inserts are used to match the size of the paintball to the
barrel to create the most accurate and efficient barrel system available.

The threaded sections of the Super Freak have 0-Rings to prevent the barrel from vibrating
loose when fired. There are also two 0-Rings within the barrel back to keep the insert from
sliding out of the barrel. Replace and lubricate with Dow 33 grease as necessary.

SUPER FREAK ASSEMBLY

1. Insert the threaded end of the barrel tip into the open section of the barrel back.

2. Hold the barrel back and turn the barrel tip clockwise until it stops (Do not over tighten).
Ensure the threads are engaged correctly and are not cross-threading which would dam-
age the both the tip and the barrel back.

3. After the tip and back are merged, choose the desired insert size and install into the barrel
back.

4. Push the insert all the way into the barrel back until it stops, if installed correctly, the insert
should be flush with the back of the barrel.

W7\ NIQUIISSH)
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To determine the correct bore size:
1. Assemble the barrel and choose an insert and install it into the barrel back.
2. Select 5-10 paintballs of the same type you will be using to play
3. Place a ball into the end of the barrel
a. Tip the barrel, if the ball rolls through without any outside force, switch to a smaller
insert. The inserts have the size engraved onto the side of each one (sized .675, .680,
.685, .690, .695)
b. If the ball barely fits into the barrel and you can’t blow it out (easily) switch to a larger
insert.
4. When the ball is blown out of the barrel listen for a small pop sound. If you can blow the
ball out of the barrel without blowing hard you should have a good ball-to-bore match.

Note: The more you exhale through the barrel, the more moisture can accumulate within the
insert and affect your testing. If you notice that the ball is starting to stick, or see a buildup
of moisture, clean and dry the barrel before continuing with the selection of bore sizes.

BARREL INSTALLATION

e The Vanquish and the supplied Super Freak barrel use Autococker threads.

* Make sure the Vanquish is de-gassed, loader removed, no paintballs in the feedneck or
breech, and the marker is turned OFF prior to installing barrel.

* While pointing the marker in a safe direction, place the threaded end of the barrel into the
front opening of the marker.

e Turn the barrel clockwise until it stops (Do not over tighten).

e Install the included barrel-blocking device. This can be barrel bag or other such device that
prevents accidental discharge of paintballs.
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Vanquish Power On/0ff

¢ Turn Marker ON - Press and hold the CENTER of the Directional
Pad (the black button/joy stick located under the screen) until
the screen illuminates to turn the board/marker ON. The Boot
Up Splash Screen will display for 3 seconds. You are now in
LIVE Mode (see below for more details) and the marker is ready
to fire.

o Turn Marker OFF - Press and hold CENTER on Directional Pad
(D-pad) to enter the MAIN Menu, release D-Pad and then press
CENTER on D-Pad when the display reads OFF to turn board off.

¢ Automatic Off feature - The Empire Vanquish also has an
automatic off feature. If you accidentally leave your marker
powered up, it will shut itself off after approximately 10 minutes
of inactivity.

Note: the Auto Off time and the Boot Screen Display are adjustable in the SYSTEM Menu

Tank Installation

The Empire Vanquish is designed to work with compressed air/nitrogen only. Do not use
CO,, as it will damage your marker. The Empire Vanquish utilizes a fully functional regula-
tor at the bottom of the grip frame that doubles as an On/Off ASA (Air Source Adapter) or
receiver for a standard threaded preset output compressed air system. If you are using an
adjustable output regulator system, the output pressure should be 500-650 psi.

WARNING

¢ Remember compressed air or nitrogen systems can be extremely dangerous if misused or
improperly handled. Use only cylinders meeting D.0.T., TC or regionally defined specifica-
tions.

¢ Never add any lubricants or greases into the fill adapter on your tank regulator.

¢ Do not install compressed air or load paintballs into your Empire Vanquish until you feel
completely confident with your ability to handle your Empire Vanquish safely.

BEFORE PRESSURIZING YOUR EMPIRE VANQUISH

¢ Check to make sure that you and anyone within range are wearing eye protection designed
specifically for paintball.

¢ Double check that all screws are tightened and no parts are loose before installing your
tank.

W7\ NIQUIISH)
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¢ Make sure the Firing Engine system is properly locked in place.

e Ensure you have a barrel plug, barrel sock, or other specifically designed barrel blocking
device in place.

e Make sure there are no paintballs in the marker and the power is off.

PRESSURIZING YOUR EMPIRE VANQUISH

¢ Flip the regulator’s On/Off ASA lever forward so it’s pointing toward the front of the marker.

e |nstall a compressed air tank, by screwing it in clockwise; making sure it’s fully threaded
into the ASA.

¢ Flip the On/Off ASA lever back so it’s flush with the regulator and pointing toward the rear
of the marker. The marker will become pressurized.

Air Source
Adapter (ASA)

ASA Lever
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DE-PRESSURIZING YOUR EMPIRE VANQUISH

¢ Make sure a barrel-blocking device is installed in/on the end of the barrel.

Turn the Empire Vanquish off using the D-Pad as explained above.

Remove loader and all paintballs from marker.

Flip the On/Off lever forward and allow the gas to vent from the regulator.

Air may remain within the marker once the regulator is vented. While the barrel blocking
device is still installed, turn your Vanquish on, turn the eyes off and pull the trigger a few
times to deplete all remaining air.

¢ Read the pressure rating and make sure the pressure reads “LOW”.

¢ Remove your air cylinder by slowly and carefully unscrewing it counter-clockwise.

Installing a Loader and Paintballs

The Empire Vanquish uses .68 caliber, water-soluble paintballs, readily available at paintball
pro-shops, commercial playing fields, and many sporting goods stores. The paintballs feed
from the loader through the neck and into the breech of the marker.

The Empire Vanquish comes equipped to accept standard-gravity feed loaders as well as
most agitating and force-feed loaders. Open the clamp lever and place the loader neck di-
rectly into the marker feed neck. Align the loader in line with the marker so the nose points in
the same direction as the barrel. Close the lever, noting that it might be necessary to adjust
the feed neck’s clamping screw to get a snug fit on your loader.

Adjustment
Screw

Feedneck
Lever
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Firing the Empire Vanquish

Keep your finger out of the trigger guard and away from the trigger, point the muzzle of your
marker in a safe direction at all times during this process. Be sure your goggles are securely in
place and make sure the Vanquish marker is off.

Warning: Everyone within firing range should always use ASTM approved eye and face
protection in the presence of live paintball markers.

¢ Place the empty loader onto the marker. Be sure that it is securely mounted in place
Install and apply the compressed gas, pressurizing the marker

Put the paintballs into the loader

Remove the barrel plug, sock or barrel-blocking device

Aim the Vanquish in a safe direction.

Turn the Vanquish ON: Press and hold the CENTER of the D-Pad to turn board/marker ON
Aim the Vanquish at the target

Pull the trigger with a smooth squeezing motion

Caution: When the game you are playing is over, remember to place the barrel blocking
device onto your barrel and turn the marker off.

Vanquish SETUP AND ADJUSTMENT

Battery Replacement and Life Indicator

The Empire Vanquish requires a single 9-volt battery as the electronic power
source. The use of brand-name batteries is highly recommended. The 9-volt
battery is located within the grip and is accessed through the removal of the grip
panel by using the 3/32” hex wrench to remove the grip screws. Confirm that
the marker is OFF before changing or installing the battery.

If there is already a battery in the grip, carefully disconnect the battery from the
battery harness, and then connect a fresh 9-Volt battery to the harness. Make
sure that there are no abrupt kinks in the wires and that they are comfortably
seated. Do not force into place. Then re-install the grip and secure with the
grip screws. The Empire Vanquish also has a battery life indicator visible on the
screen in Live Mode. The battery icon will show the power level remaining in
the battery.

Note: Some rechargeable batteries may be too large for the Empire Vanquish
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battery compartment. If they don’t fit, please don’t force them as this may cause damage.

Pressure and Velocity Adjustment

The velocity can be adjusted by adjusting the pressure. Locate the Pressure Adjustment
Screw and using the 3/32” Hex wrench, turn the screw clockwise (inward) to increase the
pressure (and velocity). Turn the screw counter-clockwise to decrease the pressure.

Turn on the Vanquish and enter the LIVE mode on the display (see below for more detail).
Press and hold the D-pad to the Left or Right for 1second at a time to change displayed infor-
mation. Repeat this process until the display cycles to pressure reading. This visual indicator
will help determine the correct pressure/velocity you desire.

W7\ NIQUIISSH)
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Trigger Adjustment
There are five adjustments that can be made on the on the trigger. Use the 3/32” hex wrench
to make any desired adjustments:

A. Magnetic Tension - this affects how “hard” the pull of the trigger is
- Turning the adjustment screws “in” or clockwise will increase the force needed to pull
the trigger
B. Forward Travel - This adjusts the position of the trigger when not being fired
- Turning the adjustment screws “in” or clockwise will decrease the trigger length of
travel
C. Stop - This adjusts the farthest position the trigger will travel when depressed
- Turning the adjustment screws “in” or clockwise will decrease the travel of the trigger
by having the trigger stop sooner
D. Activation Point - This adjusts the position where the trigger pull registers a shot
- Turning the adjustment screws “in” or clockwise will decrease the travel of the trigger
needed before the Vanquish registers a shot
E. Spring Tension - Unscrew for more tension and more resistance. This adjustment can only

be made by removing the trigger or by splitting the body and foregrip (see page 23).
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ELECTRONIC BOARD FUNCTIONS

e Turn Marker ON - Press and hold the CEN
TER of the Directional Pad (the black but
ton/joystick located under the screen) to
turn board/marker ON - You are now in LIVE
Mode (see below for more details) and the
marker is ready to fire. The D-PAD joystick
can be moved UP, DOWN, LEFT, RIGHT or
pressed IN

¢ Turn Marker OFF - Press and hold CENTER
on Directional Pad (D-pad) to enter the
MAIN Menu, release D-Pad and then press
CENTER on D-Pad when the display reads
OFF to turn board off.

¢ Automatic Off feature - The Empire Van
quish also has an automatic off feature. If
you accidentally leave your marker powered
up, it will shut itself off after approximately
10 minutes of inactivity.

Note: The Auto Off time is adjustable in the SYSTEM Menu

Boot Up Splash Screen: When the marker is turned on the screen will display the boot up
splash screen graphics for 3 seconds (Note - the boot screen display time can be changed
via the settings menu, see page 15). After the boot screen time expires the marker is in LIVE
mode and ready to fire. You may exit the boot screen and skip to LIVE mode at any time by
moving the joystick in any direction or by pressing the trigger.

Note: The boot screen graphics can be changed using the Vanquish Boot Screen Editor and
the Vanquish USB Tool on your PC. These applications come with your Vanquish Marker on
the disc with the manual.

FIRMWARE VERSION: The firmware version will display at the bottom of the standard boot
screen. If using a custom boot screen, software version will not display.

W7\ NIQUIISH)
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LIVE MODE

LIVE Mode is the standard mode when firing the marker. The main display will show the
current Firing Mode, the current Rate of Fire (ROF) setting, Battery Level, Tournament Lock
Status, Trigger Status, EYE Status, Game Timer, user preferred marker data (default is Pres-
sure Reading).

Live Mode D-Pad Controls:

e Firing Mode - The upper section of the display shows the current Firing Mode. The Van-
quish offers eight different Fire Mode options.

* Below the Firing Mode is the current Rate of Fire Cap setting, which can be changed in the
CONFIG Menu (see below for more details). This number will change depending
on whether the Eyes are On or Off.

¢ Battery Level Indicator - On the upper left of the display, below the Rate of Fire, is the Bat-
tery Level indicator. The indicator will blink when the battery is fully depleted.

¢ Tournament Lock - Below the Rate of Fire is the Tournament Lock indicator, shaped like
a padlock. The Tournament Lock is engaged when the padlock icon is closed. The Tourna
ment Lock can only be set by pressing a button on the Vanquish board (see page 16 for
more details).

* Trigger Status - The display will show the status of the trigger- a down arrow indicates that
the trigger is depressed.

* Eyes Status - Eyes are electronic light
beams that will not allow the marker to
fire until a paintball is completely loaded
into the breech and “seen”. This feature
helps eliminate chopped paintballs.
Press D-Pad in the UP direction to toggle
Eyes ON or OFF. The display icon will
show one of four settings: Eye Off, Eye
On-No Ball, Eye On with Ball, and Eye
Malfunction

¢ Game Timer - On the bottom left, the
display shows the Game Timer. Press
the D-Pad in the DOWN direction to start
the Game Timer. Press DOWN and hold
for 1second to stop the timer or hold DOWN for 3 seconds to reset the Game Timer.

* Press and Hold the D-Pad in the LEFT or RIGHT directions to display more user data.

¢ Regulator Pressure - The Vanquish Marker has a built in temperature compensated
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precision electronic pressure transducer.

This shows the marker pressure as Rate of Fire Firing

regulated by the ASA/Regulator. Cap Setting ode

The pressure transducer has a range of Trigger

50-250psi. Out of this range, Battery \E s Status

. . . Level ~ i_ 3)

pressure will not be displayed, and will Tournament

display LOW or OVER. fves — (@)~ Lock
¢ Shot Counter - The marker will keep

track of the number of shots fired. This Shot Game

number will increase each time Counter Timer

the solenoid is cycled and will be saved

even when power is disconnected. Shot

Counter can be reset in the settings

menu.

e AVG and Peak ROF’s Achieved - The Average ROF is the highest actual number of shots
that were started within 1second. The Peak ROF is the shortest time between 2 consecu
tive shots. This can be reset by pressing the center on the joystick 2 times quickly
(Like double clicking a mouse).

* Lube Gauge - The Lube Gauge will monitor how many shots have occurred since last time
the maker was lubricated. This gauge must be reset by the user when the marker is lubed
for an accurate reading. There is also an alert associated with the Lube Gauge (see page
15 for Lube Alert).

e MAIN Menu - Press and hold CENTER on D-pad to enter the MAIN Menu (see below for
more details).

MAIN MENU

The display will show “MAIN MENU” at the top of the screen indicating the Main Menu.
Press the D-pad to the RIGHT, LEFT, UP or DOWN directions to scroll through the MAIN
Menu options. Press CENTER on the D-pad to make a selection.

e OFF - Turns Marker Off

* CONFIG - Enters User CONFlGurations Menu (see below)
e SYSTEM - Enters SYSTEM Settings Menu (see below)

e EXIT - Exits back to LIVE Mode

W7\ NIQUIISH)
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Note: MENU QUICK EXIT - As long as you
are not currently modifying a setting, you
can exit any menu at any time by pressing
and releasing the trigger. This will take you
back to LIVE Mode.

CONFI6 MENU:

Note: Settings under this menu affect the markers firing characteristics and
may not be modified when tournament lock is on. Press the D-pad in the UP or
DOWN directions to scroll through the USER CONFIGURATIONS Menu options.
Press CENTER or RIGHT on the D-pad enter the selected option and see the
current setting.

User Configurations

There are 3 fully customizable user configurations (or profiles). The current user

CONFIG NUM (Profile) is displayed on the screen (1, 2, or 3).

¢ Only the settings under CONFIG menu are linked to a specific User Profile.

e |f Tournament Lock is active, the marker will beep when trying to make a
selection and you cannot modify any settings in the CONFIG tmenu.

¢ Changing the values of a setting will only affect the Profile that is currently
chosen.
If the current Profile is 1, any changes to the user settings in the CONFIG menu will
only affect Profile 1.

10
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FIRE MODE - Choose between the different firing modes

¢ The current Firing Mode setting is displayed on the right side of the screen.

Press CENTER or RIGHT to change the Fire Mode setting

Press UP or DOWN to cycle through Firing Modes

Press CENTER or LEFT to save your selection

SEMI - Semi automatic firing shoots 1 shot per trigger pull up to the max ROF

(Rate of Fire) setting

¢ RAMP - Semi auto shots (equal to Ramp Shot Start setting), then a Ramping
rate of fire up to the max ROF setting (if Ramp Sustain Trigger Pulls
per Second is achieved, see below)

e BURST - Semi auto shots (equal to Ramp Shot Start setting), then multiple-
shot bursts at the max ROF. The number of shots in the burst is adjustable in
the BURST SHOT setting. If time between shots is longer than Ramp
Reset setting the marker goes back to Semi Automatic and the Ramp
Start shot counter is reset.

¢ AUTO - Semi auto shots (equal to Ramp Shot Start setting), then Fully Automatic firing
at the ROF CAP setting. If time between shots is longer than the Ramp Reset setting the
marker goes back to Semi Automatic and the Ramp Start shot counter is reset.

e PSP B - Complies to 2010-2012 PSP rules using Burst mode as described above

e PSP R - Complies to 2010-2012 PSP rules using Ramp mode as described above

e MILL - Complies to 2010-2012 Millennium Series Rules using Ramp mode as described
above

¢ NPPL - Complies with 2012 NPPL rules using Semi Auto mode as described above

ROF CAP - Choose between having the marker Rate of Fire Capped or Un-
capped. Turning this setting ON will cap the marker at the ROF () ON setting.
Turning this setting OFF will uncap the marker and allow the marker to fire as
fast as paintballs can be loaded and detected by the eyes.

Note - Firing modes other than Semi may not be uncapped due to ASTM Safety
Regulations.

¢ The screen displays the current setting of whether ROF CAP is On or OFF

¢ Press CENTER or RIGHT to change the ROF Cap setting

¢ Press UP or DOWN to cycle through ON or OFF

e Press LEFT or Press CENTER on D-Pad to save the setting and return to
CONFIG menu
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ROF (°) ON- The maximum Rate of Fire with Eyes On (ROF Cap must be ON)

¢ The screen displays the current ROF EYES ON setting

¢ Press RIGHT or Press CENTER on D-Pad to change the ROF with EYES ON
setting

¢ Press UP or DOWN to increase/decrease the BPS setting (8.0-25.0 BPS, in
0.1BPS increments)

e Press LEFT or Press CENTER on D-Pad to save setting and return to CONFIG
menu

ROF (°) OFF - The maximum Rate of Fire with Eyes OFF

¢ The screen displays the current ROF EYES OFF setting

¢ Press RIGHT or Press CENTER on D-Pad to change the ROF with
EYES OFF setting

¢ Press UP or DOWN to increase/decrease the BPS setting
(8.0-25.0 BPS, in 0.1 BPS increments)

¢ Press LEFT or Press CENTER of D-Pad to save setting and return
to CONFIG menu

ROF Default - The maximum allowed Rate of Fire if the eyes be-

come dirty or malfunction.

¢ The screen displays the current ROF Default setting (in BPS)

¢ Press RIGHT or Press CENTER on D-Pad to change the ROF
Default setting (default is 8 BPS)

¢ Press UP or DOWN to increase/decrease the BPS setting (7-12
BPS, in 1BPS increments)

¢ Press LEFT or Press CENTER of D-Pad to save setting and return to CONFIG menu

fl
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Dwell - Is the amount of time the solenoid stays on to fire a ball.

Setting the Dwell too high will decrease efficiency. Setting the

Dwell too low will cause inconsistent velocity.

¢ The screen displays the current Dwell time(in milliseconds)

¢ Press RIGHT or Press CENTER of D-Pad to change the
Dwell Time (Default is 15.0 ms)

¢ Press UP or DOWN to increase/decrease the Dwell setting
(8.0-25.0 ms)

e Press LEFT or Press CENTER of D-Pad to save setting and return
to CONFIG menu

Pull Debounce (PULL DEB) - Time in milliseconds the trigger

pull must be held to register a valid trigger pull. This eliminates

electronic noise and vibrations that the board may wrongly interpret

as a trigger action (trigger pull) and fire the marker. Too low of a value will cause undesired

trigger pulls. Too high of a value will make it harder to achieve high rates of fire.

¢ The screen displays the current Trigger Pull Debounce setting (in milliseconds)

¢ Press RIGHT or Press CENTER of D-Pad to change the Trigger Pull Debounce setting
(default is 4ms)

¢ Press UP or DOWN to increase/decrease the Pull Debounce setting (1-20 ms)

¢ Press LEFT or Press CENTER of D-Pad to save setting and return to CONFIG menu

Release Debounce (REL DEB) - Time in milliseconds the trigger must remain released be-

fore next pull can be registered. Too low of a value will cause undesired trigger

pulls. Too high of a value will make it harder to achieve high rates of fire.

¢ The screen displays the current Trigger Release Debounce setting (in millisec
onds)

¢ Press RIGHT or Press CENTER of D-Pad to change the Release Debounce
setting (default is 6ms)

¢ Press UP or DOWN to increase/decrease the Release Debounce setting (1-20
ms)

e Press LEFT or Press CENTER of D-Pad to save setting and return to CONFIG
menu

——— www.empirepaintball.com
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AMB Level - Anti-Mechanical Bounce will help prevent “Run Away”

during sustained firing which is described as the marker shooting

extra shots when the user is not pulling the trigger. A lower value

will make it easier to maintain high rates of fire. A higher value will

prevent “Run Away.”

¢ The screen displays the current AMB Level (adjustable from level
0-10 with level O being off)

e Press RIGHT or Press CENTER of D-Pad to change the AMB
Level (default is 0)

¢ Press UP or DOWN to increase/decrease the AMB LEVEL setting
(1-10)

e Press LEFT or Press CENTER of D-Pad to save setting and return
to CONFIG menu

Ball in Place (BIP) Time - Consecutive milliseconds the Eyes must sense a ball before they
will allow the marker to fire. Increase this setting for slower feeding loaders to avoid chopping
balls in the breech. Decrease this setting for use with faster feeding loaders to increase max
ROF. This setting only has an affect when the eyes are on and not malfunctioning. If not us-
ing a force feed loader a setting of at least 10ms is recommended.

¢ The screen displays the current BIP Time (in milliseconds)

¢ Press RIGHT or Press CENTER of D-Pad to change the Ball In Place setting (default is 5ms)
e Press UP or DOWN to increase/decrease the BIP setting (1-20 ms)

¢ Press LEFT or Press CENTER of D-Pad to save setting and return to CONFIG menu

Anti-Bolt Stick (ABS) Wait Time - The time in seconds that must expire after

a shot before ABS is activated. This helps prevent first shot drop-off. ABSis a

feature to compensate for stiction of the bolt which causes low velocity on first

shots of a string.

¢ The screen displays the current ABS Wait Time (in seconds)

e Press RIGHT or Press CENTER of D-Pad to change the ABS Wait setting
(default is 60s)

¢ Press UP or DOWN to increase/decrease the ABS Wait setting (10-200 sec, in
10 second increments)

e Press LEFT or Press CENTER of D-Pad to save setting and return to CONFIG
menu

12
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Anti-Bolt Stick (ABS) Dwell - Time that the dwell is increased by

for the first shot when ABS is activated. Too high of a setting may

cause first shot of a string to have high velocity. Too low of a set-

ting may cause excessive bolt stick or first shot drop off.

¢ The screen displays the current ABS Dwell Time (in millisec
onds)

¢ Press RIGHT or Press CENTER of D-Pad to change the ABS
DWELL setting (default is 3ms)

¢ Press UP or DOWN to increase/decrease the ABS Dwell setting
(0-10 ms)

e Press LEFT or Press CENTER of D-Pad to save setting and
return to CONFIG menu

Ramp Start - Number of Semi-Auto shots needed before selected

firing mode kicks in (affects all firing modes but Semi-Auto and NPPL).

¢ The screen displays the current Ramp Start setting (in # of shots)

¢ Press RIGHT or Press CENTER of D-Pad to change the Ramp Start setting (default is 3
shots)

¢ Press UP or DOWN to increase/decrease the Ramp Start setting (3-12 shots)

e Press LEFT or Press CENTER of D-Pad to save setting and return to CONFIG menu

Ramp Sustain - Trigger Pulls per Second (TPS) that must be

maintained to continue ramping (affects RAMP, PSPR and MILL

modes).

¢ The screen displays the current Ramp Sustain setting (in trigger
pulls per second)

¢ Press RIGHT or Press CENTER of D-Pad to see current Ramp
Sustain setting (default is 3)

¢ Press UP or DOWN to increase/decrease the Ramp Sustain set
ting (3-12 TPS)

e Press LEFT or Press CENTER of D-Pad to save setting and
return to CONFIG menu

Ramp Reset - Time after the last trigger pull before Ramp Start
Shot count will reset (affects all modes except Semi and NPPL).
¢ The screen displays the current Ramp Reset (in seconds)

¢ Press RIGHT or Press CENTER of D-Pad to change the Ramp Reset setting (default is 1.0)
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¢ Press UP or DOWN to increase/decrease the Ramp Reset setting (0.1-1.0 sec)
e Press LEFT or Press CENTER of D-Pad to save setting and return to CONFIG menu

Burst Shots - Determines how many shots are fired at each trigger

pull when marker firing mode is BURST or PSP B. This setting will

only affect BURST and PSP B firing modes.

¢ The screen displays the current Burst Shots setting (in # of
shots)

¢ Press RIGHT or Press CENTER of D-Pad to change the Burst
Shots setting (default is 3 shots)

¢ Press UP or DOWN to increase/decrease the Burst Shot setting
(2-6 shots)

e Press LEFT or Press CENTER of D-Pad to save setting and return
to CONFIG menu
Back - Return to MAIN Menu

¢ Press RIGHT or Press CENTER of D-Pad when BACK is visible to
return to the MAIN Menu.

SYSTEM MENU

Settings under this menu affect secondary functions of the marker that do not have to do with
firing characteristics.

Navigating the System Menu

¢ Press the D-pad in the UP or DOWN directions to scroll through the SYSTEM
Menu options. The current setting for each option will be displayed on the
right side of screen.

¢ To select a setting for modification press the D-Pad RIGHT or CENTER.

e Tilt the D-Pad UP or DOWN to modify the setting value.

o Tilt the D-Pad LEFT or press CENTER to save the setting and go back to the
System Menu.

Game Timer - Set the Game Timer countdown duration.
¢ The screen displays the current Game Timer duration - MM = Minutes, SS =
Seconds (MM:SS)
¢ Press the D-Pad Right or Center to change the duration time (default 7:10)
¢ Press UP or DOWN to increase/decrease the
Game Timer minutes (00-99)

13
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Press CENTER of D-Pad to save minutes setting

Press UP or DOWN to increase/decrease the

Game Timer seconds (00-59)

Press CENTER of D-Pad to save seconds setting

Press LEFT or Press CENTER of D-Pad to save settings and return to
SYSTEM Menu

Timer Alarm - An audible alarm sounds with 1 minute left and continuously

after the timer has expired.

¢ Press RIGHT or Press CENTER of D-Pad to change the setting from On or
OFF

¢ Press UP or DOWN to cycle through ON or OFF (default is ON)

¢ Press LEFT or Press CENTER of D-Pad to save the setting and return to
SYSTEM Menu

Trigger CMD - After holding the trigger for 1 second while the marker is Live, Trigger Com-
mand allows the marker to perform a function, either Force Shot,
or Toggle the Eyes On or Off, or both. A Force Shot is when the
marker will cycle once with the Eyes ON even though there is no
ball in the breech. This is to allow sound activated loaders to be-
gin loading. The Trigger Command may also be set to OFF which
will not perform any function when the trigger is held for 1 second.
¢ The screen displays the current setting of the Trigger Command
e Press RIGHT or Press CENTER of D-Pad to change the Trigger
Command (either OFF, TOGGLE, FORCE or BOTH)
¢ Press UP or DOWN to cycle through ON or OFF (default is
BOTH)
e Press LEFT or Press CENTER of D-Pad to save setting and
return to SYSTEM menu

Dwell Lock - When selected ON, changing the Dwell Setting in

any of the 3 user configurations (C1, C2, C3) will change the dwell for all 3 configurations.
When OFF, the dwell in each user configuration can be changed independently.

The screen displays the current setting of either ON or OFF

Press RIGHT or Press CENTER of D-Pad to change the Dwell Lock setting (default is ON)
Press UP or DOWN to cycle through ON or OFF

Press LEFT or Press CENTER of D-Pad to save the setting and return to SYSTEM Menu
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Brightness - Adjustable the brightness of the screen display when screen is not dimmed
(A numerical

¢ The screen displays the current setting of the Brightness setting

value of 10%-100%, where 100% is the brightest

setting)

¢ Press RIGHT or Press CENTER of D-Pad to change the Bright
ness setting (default is 50%)

¢ Press UP or DOWN to increase/decrease the Brightness setting
(10-100)

e Press LEFT or Press CENTER of D-Pad to save the setting and
return to SYSTEM Menu

Dim Time - The elapsed time after the last joystick activation in

which the screen will dim to save power.

¢ The screen displays the current Dim Time setting (in seconds)

e Press RIGHT or Press CENTER of D-Pad to change the Dim Time
setting (default is 10 sec)

¢ Press UP or DOWN to increase/decrease the setting (5-60 sec, in 5 sec intervals)

e Press LEFT or Press CENTER of D-Pad to save setting and return to SYSTEM menu

Auto Off - The elapsed time after the last trigger activation in which marker will shut off to

save power.

¢ The screen displays the current Auto Off setting (in minutes)

¢ Press RIGHT or Press CENTER of D-Pad to change the Auto Off
time (default is 10 min)

¢ Press UP or DOWN to increase/decrease the Auto Off setting
(5-60min, in 5 minute intervals)

e Press LEFT or Press CENTER of D-Pad to save setting and
return to SYSTEM menu

Custom Boot - This setting allows the user to turn the use of the
custom boot screen graphics on/off. Custom boot screens can be
made and downloaded using the Vanquish Boot Screen Editor and
the Vanquish USB Tool software. These applications are included
with the Vanquish on disc manual.

Note - if a custom boot screen has not been downloaded but the
user turns it on the default boot screen will display. The firmware version will not display
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when the custom boot screen is turned on.

¢ The screen displays whether the Custom Boot setting is On or Off

¢ Press RIGHT or Press CENTER of D-Pad to change the Custom Boot setting (default is
OFF)

¢ Press UP or DOWN to switch the setting to either ON or OFF

o Press LEFT or Press CENTER of D-Pad to save setting and return to SYSTEM menu

Boot Time - This setting changes the amount of time the boot up splash screen is displayed

when the marker is turned on. This time is adjustable from 0-5seconds W|th a settin of 0 not

displaying the splash screen at all. This setting applies to both the :

standard and custom boot screens.

¢ The screen displays the current Boot Time setting (in seconds)

¢ Press RIGHT or Press CENTER of D-Pad to change the Boot
Time setting (default is 3 sec)

¢ Press UP or DOWN to increase/decrease the setting (0-5 sec)

e Press LEFT or Press CENTER of D-Pad to save setting and
return to SYSTEM menu

PRES SIZE - There are two font size options for displaying the

Regulator Pressure - Large or Small.

¢ The screen displays whether the PRES SIZE setting is Large or
Small

¢ Press RIGHT or Press CENTER of D-Pad to change the Pres Size

setting (default is Small)

¢ Press UP or DOWN to switch the setting to either SMALL or LARGE

e Press LEFT or Press CENTER of D-Pad to save setting and return to SYSTEM
menu

System (SYS) Sound - Turns the system sounds ON or OFF, including the

startup, shutdown, and enter/exit menu sounds.

¢ The screen displays the current setting of either ON or OFF

¢ Press RIGHT or Press CENTER of D-Pad to change the System Sound (default
is ON)

¢ Press UP or DOWN to cycle through ON or OFF

e Press LEFT or Press CENTER of D-Pad to save setting and return to SYSTEM
Menu

JSTK Sounds - Joystick Sounds: Enables a beep when the joystick is activated
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when setting is ON.

¢ The screen displays the current setting of either ON or OFF

¢ Press RIGHT or Press CENTER of D-Pad to change the Joy
stick Sound setting (default is ON)

¢ Press UP or DOWN to cycle through ON or OFF

e Press LEFT or Press CENTER of D-Pad to save setting and return
to SYSTEM Menu

Lube Alert - This setting turns the Slick Assistant lube alerts ON or
OFF. The Slick Assistant lubrication monitoring system will alert
the user if it is time to re-lube the marker. This alert plays a sound
and shows a special alert message on screen when the marker is
turned on. It also plays a sound if the Slick Assistant Lube Gauge is
displayed during live mode.

¢ The screen displays the current setting of either ON or OFF

¢ Press RIGHT or Press CENTER of D-Pad to change the Lube Alert setting (default is ON)
¢ Press UP or DOWN to cycle through ON or OFF

o Press LEFT or Press CENTER of D-Pad to save setting and return to SYSTEM Menu

Reset Lube - This setting will reset the lube gauge. This should be reset each time the marker
is lubed. Two choices reset or cancel

Training - When training mode is ON, while in Live Mode, instead of

the marker cycling the solenoid, it will chirp quickly. The eyes are

bypassed. This is for users to practice trigger activation without the

need for an air source. Note - the marker will not fire while training

mode is on.

¢ Press RIGHT or Press CENTER of D-Pad to see if Training Mode
setting is On or OFF

¢ Press UP or DOWN to cycle through ON or OFF (default is OFF)

¢ Press LEFT or Press CENTER of D-Pad to save setting and return
to SYSTEM Menu
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RST Shots - Reset Shot Counter: Resets the Shot Counter when

YES is selected (also available through LIVE Mode menu)

¢ Press RIGHT or Press CENTER of D-Pad to Reset Shot Counter

e Press LEFT or Press CENTER of D-Pad to reset the counter, then
return to SYSTEM Menu

FCTRY RST - Factory Reset: Resets all settings to factory defaults

when YES is selected

¢ Press RIGHT or Press CENTER of D-Pad for FACTORY RESET

¢ Press UP or DOWN to cycle from NO to YES

e Press LEFT or Press CENTER of D-Pad to activate RESET if YES
is set

¢ Screen will then display “Resetting” and then will shut down

BACK - Selecting will return you to the MAIN Menu
e Press RIGHT or Press CENTER of D-Pad to return the MAIN Menu

TOURNAMENT LOCK

The tournament lock can be toggled on/off by using the tournament lock button located just
in front of the trigger on the underside of the body. The marker will play a distinct sound
when the tournament lock is toggled and the on screen tournament lock icon will change
accordingly.

SOFTWARE VERSION

e On startup, the software
version will display next to
the logo.

¢ Hold CENTER on D-Pad
during startup to
continuously display
the logo and software ver
sion.

Tournament
Lock

——— www.empirepaintball.com
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VANQUISH MENU TREE

OFF

Turns Vanquish Off

(these settings are locked when tournament lock is active)

User Profile
1,2,3 3 Fully customizable user configurations - only settings under CONFIG menu are linked to a User Profile
Firing Mode
Semi Semi automatic firing up to max ROF setting
Ramp Semi to Ramp Start Shots then step up to ROF Cap setting if Ramp Sustain Trigger Pulls per Second (TPS) is achieved
Burst Sem/ to Ramp Starti Shots then fires at ROF Cap setting for Burst Shot amount
Full Auto Semi to Ramp Start Shots then Fully Automatic at ROF Cap setting
PSP B Compliant with PSP 2010-2012 rules using Burst mode described above
PSP R Compliant with PSP 2010-2012 rules using Ramp mode described above
MIL 10 Compliant with 2010-12 Millennium Series rules using Ramp mode as described above
NPPL Compliant with 2012 NPPL Rules using Semi Auto mode as described above
ROF CAP
ON/OFF Toggle On/Off for ROF Cap with Eyes ON
ROF EYES ON
8.0-25.0BPS Max Rate of Fire with Eyes ON (ROF Cap must be ON)
ROF EYES OFF
w 8.0-25.0BPS Max Rate of Fire with Eyes OFF
[ | Dwell
m 8.0-25.0ms Dwell; solenoid on time in milliseconds
z PULL DEB
1-20ms Trigger Pull De-bounce; time in milliseconds trigger pull must be held to be valid
o REL DEB
U 1-20ms Trigger Release De-bounce, time in milliseconds trigger must remain released before next pull can be activated
AMB LEVEL
0-10 Helps prevent bounce during rapid fire.
BIP TIME
| 1-20ms Ball In Place time, time in miliiseconds ball must stay in breech before it can be fired
ABS WAIT
10-200s Anti-Bolt Stick Wait Time; time that must expire after a shot before ABS is activated
ABS DWELL
0-10ms Anti-Bolt Stick Dwell; time in miliiseconds that will be added to dwell after ABS Wait time to prevent bolt stick
RAMP START
3-12 shots Ramp Start; number of Semi-Auto shots before ramping kicks in (affects all fiiring modes but semi-auto)
BURST SHOTS
2-6 shots Amount of shots per pull, used when in Burst mode
RAMP SUSTN
3-12TPS Ramp Sustain; Trigger Pulls per second that must be maintained to ramp (only used in RAMP and Mil 10 modes)
RAMP RESET
0.1to 1.0s Ramp Reset; time in seconds after last trigger pull in which ramping will stay active
BACK Back to Main Menu

www.empirepaintball.com
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SYSTEM

GAME TIMER

TIMER ALARM

TRIGGER CMD

DWELL LOCK

BRIGHTNESS

DIM TIME

AUTO OFF

CUSTM BOOT

BOOT TIME

PRESSURE SIZE

VANQUISH MENU TREE
00:00 - 99:59 Game Countdown Timer; MM:SS -> MM = Minutes, SS = Seconds
On/Off Game Timer Alarm; audible alarm sounds when game time expires if on

None, Force, Toggle

Trigger Command,; Function for trigger being held for 1second. None=No Function, Force=Force Shot, Toggle=Toggle Eyes

On/Off Dwell Lock; When on all 3 user profiles will have the same dwell setting. When off each profile may have a different Dwell value
10-100% Screen Brightness; Adjusts brightness of screen when not dimmed

5-30s Dim Time, time after last joystick activation in which screen will be dimmed

5-30min Auto Off; time after last trigger activation in which marker will be shut off

On/Off Custom Boot Screen, Turns on user designed custom boot screen

0-5 seconds Anmount of time boot screen will display when marker is turned on

Small/Large

Regulator Pressure Display Text Size; Changes size of text of regulator pressure display

EXIT

SYS SOUND
On/Off System Sounds; turns system sounds on/off incl. startup, shutdown, enter/exit menu sounds
JSTK SOUNDS
On/Off Joystick Sounds,; turns beep when joystick is activated on or off
LUBE ALERT
On/Off Slick Assistant Lube Alert, Turns alert screen on boot up and alert sounds on or off
RESET LUBE
Reset/Cancel Reset the lube gauge back to full if reset is chosen
TRAINING
On/Off Training Mode; when on eyes are bypassed, solenoid does not cycle, marker chirps when fired
RESET SHOT
Reset/Cancel Resets shot counter back to zero
FCTRY RST
Reset/Cancel Factory Reset, resets all settings to factory defaults
BACK

Back to Main Menu

Exit Main Menu to LIVE mode

www.empirepaintball.com
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Vanquish PC SOFTWARE

The Vanquish PC Software consists of two separate applications, the Vanquish USB Tool
which allows communication between the PC and Vanquish, and the Vanquish Boot Screen
Editor which allows users to create custom boot screens that can be downloaded onto the
Vanquish via the Vanquish USB Tool.

PC Requirements:

¢ Windows Vista, XP or 7 Operating System
¢ Hardware requirements

¢ 900 Mhz or faster processor

e Min. 128 MB RAM

e 25 MB of available hard disk space

Software Installation
Step 1- Vanquish PC Software Installation “’
1. Insert the CD into your PC or download the files from _ S VPC Setup.exe

N

www.PaintballSolutions.com

2. View the contents of the software files and double-click
on “VPC Setup.exe” and follow the onscreen instructions for
software installation to your PC.

Note: Do NOT open the Vanquish PC software until instructed below!

Step 2 -

Ensure marker is Safe by removing the gas source and all paintballs before proceeding with
USB connection. With the Vanquish turned OFF, remove the firing engine and loosen the
front grip screw of the Vanquish Marker to access the USB port (see page 24). Connect your
Vanquish to your PC via the USB cable that came with the marker.

Note: The battery must be connected to the Vanquish for the USB connection to work.

Step 3 - Installing USB Drivers

Access the USB port on the Vanquish Marker Circuit board and connect the board to your
computer via USB cable. If you have an active internet connection, proceed to Step (A). If
not proceed to Step (B).
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished instaliing the software for

3 USB Serial Port

Click Finish to close the wizard

A. If you have an active internet connection the drivers will automatically install. Simply allow
windows to install the drivers for you and wait for the installation to complete. Note- windows
may install several drivers. If windows does not automatically install proceed to (B) below.

B. To manually install the FTDI USB/COM/Serial drivers please proceed below to the area that
matches the Windows version you use:

Windows XP Manual Install:

1. After connecting the Vanquish to the USB port, the New Hardware Found Wizard should
appear.

2. Select the option “No, not this time” and click “Next” to continue.

3. Select “Install from a list or specific location (Advanced)” and click “Next”.

4. Under “Search for the best driver in these locations” Browse to the “USB Drivers” folder in
the Vanquish PC Software Folder then click “Next”.

5. Depending on how your system is configured windows may pop up a warning. Click “Con
tinue Anyway”.

6. Windows will then proceed to install the first set of drivers. Click “Finish” after complete.

1. After this the New Hardware Found Wizard should appear again to install the second set of
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drivers. Proceed as before with steps 2-5 to install.

Windows Vista Manual Install:

1. After connecting the Vanquish to the USB port the New Hardware Found window will ap-
pear.

2. Select “Locate and install driver software (recommended)”.

3. When windows asks for the disk select “I don’t have the disc, Show me other options”.

4. Windows will say it could not find driver software. Click “Browse my computer for driver
software”.

5. Browse to the USB Driver Folder in the Vanquish PC Software Folder. Windows should
install the first driver.

6. After installing the first driver the New Hardware Found Window should pop up again to
install the second driver. Repeat steps 2-5 to install the second driver.

Windows 7 Manual Install:

1. With Vanquish connected to USB Port go to Start > Control Panel.

2. Select “Hardware and Sound”.

3. At the next screen select “Device Manager” under “Devices and Printers”.

4. In the Device Manager window under “Other Devices” there should be a device with a
name similar to “FT232...” with a yellow warning symbol next to it, indicating the driver is
not installed. Right-click this to bring up a small menu.

5. Select “Update Driver Software”.

6. Next select “Browse my computer for driver software”.

7. Browse to the USB Driver folder in the Vanquish PC Software Folder. This should install
“USB Serial Converter” which is the first driver.

8. To install the second driver repeat steps 4-6. This should install USB Serial Port.

Finish Installation

Open the Vanquish USB Tool application (Vanquish USB Tool.exe) and the Vanquish Marker
should automatically connect to the USB Tool. The status bar in the bottom of the window
will indicate that the Vanquish has been connected.
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Using the Vanquish USB Tool Software

The Vanquish USB tool allows users to complete the following tasks: edit and sync settings
with the Vanquish, save settings to the PC, download custom boot screens onto the Vanquish,
and update the Vanquish software.

1. Assure all paintballs and the gas source is removed from marker and marker has been
safely discharged before connecting marker to your PC.

2. Remove bolt system and remove front grip frame screw to expose mini USB port on under
side of the main circuit board (see page 24).

3. Connect USB cable between marker and PC.

4. Open the Vanquish USB Tool program and the marker will automatically connect to the
Vanquish USB Tool.

5. If the Vanquish USB Tool software program is already open, press Connect.

ONCE CONNECTED:

Once the Vanquish is successfully connected to your PC, the User Configurations and System
Settings will be loaded from the Vanquish board and automatically shown in the Vanquish
USB Tool.

Users have the ability to:

-Change settings and load them to the marker

-Load settings from a file on the PC and load them onto the marker

-Save currently displayed settings onto the PC

-Flash new software onto the Vanquish

-Load Custom Boot Up Screens onto the Vanquish
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¥ Vangquish USB Tool

File Program Help

Ramp Reset Time:

1.0 seconds

o R == = b=

Connect Disconnect Save Settings Load Settings Sync Set
o &

{ Config 1'\/ Config 2 \/ Config 3 \/ System \

Firing Mode: Semi-Auto b

ROF Cap On/Off: ON v

Eyes On ROF: 15.0 bps

Eyes Off ROF: 15.0 bps

Eye Default ROF 8bps

Dwell: 15.0ms

Trigger Pull De-Bounce: 4ms

Trigger Release De-Bounce: 6ms

Anit-Mechanical Bounce ol

Ball-In-Place Time: 4ms

Anti-Bolt Stick Wait Time: 90 sec

Anti-Bolt Stick Dwell: oms

Ramp Semi Shots: 3 shots

Burst Shot Count 3 shots

Ramp Sustain: Stps

Com Error 1, Check battery and USB Cable Connection then click Connect

How to Sync Settings with Vanquish Marker

Click “Sync Settings” to sync the setting on the Tool software with the
connected Vanquish marker. The settings must be synced before the

changed settings appear on the Vanquish marker. The Status bar and
pop-up messages will notify users when the sync is complete. Syncing
the settings usually takes around five seconds.

——— www.empirepaintball.com
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How to Save Settings to PC

Click Save Settings and follow the prompt to save the current settings from
the Vanquish USB Tool. Configuration 1, 2, 3 and System settings will be
saved on the PC. The file format is .txt so it may be edited outside of the
Vanquish USB Tool.

How to Load Settings from PC

Click “Load Settings” and follow the prompt to open and =
load a Vanquish settings file into the Vanquish USB Tool
software. Click “Sync Settings” to sync the loaded set-

tings with the Vanquish. Settings files are in .txt format,
so they can also be edited outside of the Vanquish USB

Tool.

Load Settings

How to Update the Vanquish Board Software

Clicking “Update Software’ will open a prompt that allows the user to select
a Vanquish Firmware File (.vff). When the file is selected the software will
be downloaded onto the Vanquish. The Status Bar and popup messages
will notify users when the update is complete. This process typically takes
between 30-45 seconds.

How to Download Custom Boot Screens to Vanquish

Click “Download Custom Boot Screen” and follow the prompt to
choose a Vanquish Boot Screen File (.vbs) from the PC. Vanquish
Boot Screen files are created with the Vanquish Boot Screen Editor
(see below). When the file is selected the custom boot screen will be

=l

Save Settings

e

&

Update Software

downloaded onto the Vanquish. The Status Bar and popup messages will notify users when

the download is complete. The download typically takes about 5 seconds.

To Disconnect the Vanquish from the PC

Select PROGRAM->DISCONNECT to stop communication between marker and PC.
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Vanquish Boot Screen Editor Software

The Vanquish Boot Screen Editor allows you to make your own custom graphics that can be
loaded onto you Vanquish Paintball marker using the Vanquish USB Tool software. These
graphics can be displayed when you turn on the Vanquish to make your Vanquish unique to

you.

The Vanquish Screen is 128 pixels high by 32 pixels wide.
The Boot screen editor gives you access to each individual

pixel. A white pixel in the editor shows how the pixel will be

illuminated on the Vanquish screen. A black pixel signals
the pixel will not be illuminated.

Using the Vanquish Boot Screen Editor
- Pixels that are turned On are White. Left click a pixel
with the mouse to turn it On.
- Pixels that are turned Off are Black. Right click a pixel
with the mouse to turn it Off.

Saving Boot Screens

Click File>Save to save the custom boot screen. The graph-

ics created in the Vanquish Boot Screen Editor are saved
in a Vanquish Boot Screen file (extension .vhs). Only .vbs
files can be downloaded onto the Vanquish Marker. You
must save the boot screen before it can be downloaded
onto the Vanquish Marker. To download a custom boot
screen onto the Vanquish Marker see Download Custom
Boot Screens to Vanquish (see above).

Other Controls

e anauin oot o :d'_w

File Options View Help

- Click File > Open to load a previously saved Vanquish Boot Screen file.
- The overall size of the editor window can be expanded by dragging the corner of the win-

dow.
- Zoom In by using the Options menu, View > Zoom In.
- Show normal size by selecting, View > Normal Size.

- Clear screen (all pixels black) by selecting Options > Clear Screen.

- Fill screen (all pixels white) by selecting Options > Fill Screen.

——— www.empirepaintball.com
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- Invert screen by selecting Options > Invert Screen. This turns white pixels to black and black

pixels to white.

Vanquish PC Software Troubleshooting

Vanquish USB Tool will not Connect to Vanquish

- In the Vanquish USB Tool press Disconnect. Then attempt to
connect by pressing Connect.

- On the Vanquish, disconnect the USB cable and disconnect
the battery. Then re-connect the battery and then the USB
cable in that order. Click Connect to attempt to connect again.
- Restart Vanquish USB Tool

- With the USB cable and battery connected to the Vanquish,
in the Vanquish USB Tool, go to Program > USB Tool Options to

o

Connect

open the settings menu. Under “Com Port” select the Com port named “USB Serial Port”
(see picture below). [f this choice is not available, the USB drivers have not been installed.

See the section above for instructions to install the USB Drivers.

Communication

COM Port:

| Communications Port (COM1)

Comm Baud Rate

Software Update Options

| Load Default Settings When Updating Software

2
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The Status Bar Says “Com Error 1...” or “Com Error 2...”

- On the Vanquish, disconnect the USB Port and disconnect the battery. Then re-connect
battery and then the USB Cable in that order. Click Connect to attempt the connection
again.

The Status Bar Says “Flash Error 1...” or “Flash Error 2...”

- On the Vanquish, disconnect the USB Port and disconnect the battery. Then re-connect
battery and then the USB Cable in that order. Click Connect to attempt the connection
again.

Cannot run/open Vanquish USB Tool or Vanquish Boot Screen Editor

The required Microsoft files may not be installed on your computer. These files can be
installed by running the installers located in the Vanquish PC Software directory, (Typically
C:\Documents and Settings\*Windows User Name*\Vanquish PC Software\MsVcRd). Select
the 32bit version for 32 bit Windows systems or 64bit version for 64bit Windows systems.

- If you are not sure of whether your Operating System is 32bit or 64bit, this information
can be found n the Control Panel under the Start menu. Once in the Control Panel, click on
System - the OS version will be displayed in the System screen.

Still having trouble? Contact paintballsolutions.com to speak with tech support personnel.

GENERAL MAINTENANCE

CAUTION: Before attempting to perform any maintenance operations, make sure that all
paintballs and air sources have been removed from the marker and that the regulator pres-
sure reads LOW psi. Install a barrel-blocking device, and ensure the Vanquish power is OFF.

Keep your Empire Vanquish clean and lubricated to eliminate the friction that would prevent
reliable operation. It is recommended that you clean and lube the marker before each use.

Do not use oil or petroleum-based lubricants in the lubrication of this marker. Teflon or silicon
(non-spray only) lubricants designed for use on 0-Rings may be used for lubrication for the
Firing Engine. SL33K, Dow 33 or the included factory lubricant is recommended.

CAUTION: Before attempting to perform any marker disassembly, make sure that all
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paintballs and air sources have been removed from the marker and that the regulator
pressure reads LOW. Install a barrel-blocking device. Confirm the Empire Vanquish is
powered OFF.

Disassembly Tips

¢ Make sure you have a clean area to work on your marker, so you don’t lose or misplace
parts.

o After reassembling the Empire Vanquish recheck your trigger activation settings.

e Visit PaintballSolutions.com for additional information.

External Cleaning

Use a clean cloth, dampened with water to clean the outside of the Empire Vanquish. Do not
use any chemicals or cleaners, as you may damage the protective finish.

Warning: Do not rinse the Empire Vanquish under water, as you may damage the
marker’s electronics.

Barrel

It is recommended that all sections of that the barrel be removed before any maintenance or
disassembly is performed. Simply turn the full barrel counter-clockwise to remove. Use warm
water and a barrel cleaning device to keep the barrel in top condition. Dry thoroughly.

Firing Engine Assembly

Removal of Firing Engine

Before you remove the Firing Engine, make sure you remove the air cylinder from the marker
and that the pressure reads LOW psi.

¢ Push and hold in the Back Cap Release Button at the rear of the marker while the rear of
the marker is facing a safe direction

While holding the button in, turn the Back Cap clockwise until it stops

Now pull the Back Cap back until it stops

Next, rotate the Back Cap assembly counterclockwise until it stops

The Firing Engine can now be pulled free of the Body
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Maintenance of Firing Engine 4. Unscrew the Bolt Guide from the Back Cap. Remove old grease and debris from Firing
Firing Engine maintenance should be performed approximately every 10,000 - 20,000 shots. Engine.
1. Remove the Bolt Tip from the bolt by squeezing the rubber tip and pulling it off.

=

2. Unscrew the Air Guide by turning the Air Guide counter-clockwise to remove from the
Back Cap. The Bolt Spring will come out with the Bolt Guide.

=

5. Wipe the parts down with a clean rag removing any old grease or debris.

6. Inspect the 0-Rings on both the bolt and Air Guide for any wear or damage. Replace dam
aged or worn O-Rings if necessary.

7. Lubricate the inner 0-Ring on the Back Cap (#5 from 0-Ring Diagram).

WO
=

3. Push the Bolt out of the back of the Air Guide.

1 8. Apply grease to #6 Bolt O-ring and apply a light coat of grease to entire bolt.

——— www.empirepaintball.com
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9. Apply grease to the two small 0-Rings on the Rod #8a, #8b.

10. Lubricate the 3 inner 0-Rings on the Air Guide (#2a, #2b, #2¢), no lube is needed on the
outer O-Rings.

11. Apply a light coat of grease on the inner surface of the Air Guide, where the Bolt O-Rings
make contact.

12. Reassemble the Firing Engine in the reverse order of Step 3 thru 1.
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Firing Engine O-Ring Guide
1 Air Guide O-ring - UR 020/70 (72558)
Air Guide (Internal) O-ring - UR 017/70 (72556)
Back Cap O-ring - BUNA 019/70 (72557)
Back Cap O-ring - UR 020/70 (72558)
Back Cap (Internal) O-ring - UR 017/70 (72556)

6 Bolt O-ring - BUNA 015/90 (72549)
7 Bolt O-ring - UR 016/70 (72555)
8 Rod O-ring - UR 013/70 (72552)
9 Rod O-ring - UR 014/20 (72553)
10 Rod O-ring - BUNA 015/70 (72554)

v s wN

Back
Cap

Bolt

Cleaning the Eyes / Ball Detents

The eyes should be cleaned thoroughly after a ball break. Leaving paint on the eyes for an
extended amount of time may cause damage to the electrical contacts. Remove the eye cover
to access the eye board. Use a cotton swab to remove paint or debris in the body and off of
the eye board. Ensure that the path in front of the eyes is clear and reinstall the eye boards
and eye covers.

The Eyes should be cleaned thoroughly after a ball break in the breech. Leaving paint on
the Eyes for an extended amount of time can damage the electrical contacts and cause a
malfunction.

¢ Remove the Eye Cover using the 3/32” Hex wrench to access the Eye Board
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e Carefully remove the Eye Board from the body

¢ Use a Q-tip to remove any paint or debris from the Eye Board and the Eye cavity of the
Body

¢ Ensure that the opening in front of the Eyes is clear and that the laser has a clear path to
the opposite Eye.

¢ |nspect the Ball Detents, faulty or worn out Ball Detents can cause double feeding or ball
breaks

¢ Clean or replace as necessary

¢ Re-install the Eye Board and Eye Cover. Repeat process with the opposite Eye Boards if
necessary

Trigger Maintenance

The Trigger is removed using a single screw located on the side of the Grip Frame (see image
below). Using the 3/32” Hex wrench, remove the screw to free the Trigger. Once the Trigger
is free, inspect for any paint or debris and clean with a cloth dampened with water. The
Spring Tension can be adjusted with the Trigger removed. If necessary, clean the bearings
to ensure a smooth trigger pull. The bearings can be lubricated with a drop or two of marker
oil on the side housing. To re-install, place the trigger back in the Grip frame and replace the
Trigger Retention screw.

Regulator
Removal of Regulator
¢ Remove the two regulator mount screws located on the bottom of the grip frame with a
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3/32” Allen wrench by turning them counter-clockwise.

¢ Make sure the 0-Ring is on the bottom of the air tube; grease if necessary.

e Slide regulator back into the grip frame and tighten the regulator mount screws with a
3/32” Allen wrench.

Installation of Regulator Assembly

e Make sure the air transfer 0-Ring is on the bottom of the grip frame; grease if
necessary.

e Slide regulator back into the grip frame and tighten the regulator mount
screws with a 3/32” Allen wrench.

Warning: Do not take the regulator apart; it is not designed to be user serviceable. Damage to
the regulator will not be covered under warranty.

Splitting the Body

1. Remove the Firing Engine assembly from the Body (see pg x)

2. Locate the screw that holds the Body to the Grip Frame, it is located at the front of the
marker, within the Front Grip below where the Barrel meets the Body.

3. Using the 3/32” Hex wrench, completely loosen the screw holding the Body to the Grip
Frame.

4. The Body can now be opened away from the Grip Frame hinging at the back of the marker.

5. Once open, you can access the Main Board and the USB port for PC connection.
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TROUBLESHOOTING GUIDE

MARKER LEAKS

There is a constant leak coming from under the
body/trigger frame area

There is a consistent leak in the breech or down the
barrel of the marker

There is a constant leak from the exhaust holes on the
back cap of the firing engine

There is a constant leak coming from between the
bottom of the grip frame and the ASA/regulator

Clean and Lubricate the Firing Engine as described in this manual

Check the Regulator pressure using the on screen read out and ensure the pressure is below 200psi.

Check O-ring on outside of Air Guide, 4th from the front of the marker (Firing Engine Diagram #1d). Size -020
Urethane

Check the O-ring on the outside of the Bolt nearest to the rear of the marker (Firing Engine Diagram #7) and
replace if necessary. Size -016 Urethane

Check the Air Transfer O-ring located on the underside of the Body just behind the main circuit board and
replace if necessary. Size Imm X 5mm Buna

Remove the main circuit board and check the O-ring located on the Pressure Sensor (The silver cylinder located
near the rear of the circuit board). Replace O-ring if necessary. Size -011 Buna

Remove the Solenoid and check the 3 Solenoid O-rings located on the underside of the body. Replace if
necessary,_Size lmmXSmmBuna_ __ __ ____ e
Check the O-ring on outside of Air Guide closest to the front of the marker (Firing Engine Diagram #1a) and
replace if necessary. Size -020 Urethane

Check the O-ring on Rod closest to front of the marker (Firing Engine Diagram #8a) and replace if necessary. Size
013 Urethane

Check the O-ring on inside of Air Guide closest to front of marker (Firing Engine Diagram #2a) and replace if
necessary, Sjze 017 Urethane, _ _ _ e
Check the O-ring on the Rod nearest to rear of the marker where the Air Guide screws into the Back Cap (Firing
Engine Diagram #10) and replace if necessary. Size -015 Buna

Check the O-ring on the Rod, 2nd from the front of the marker (Firing Engine Diagram #8b) and replace if
necessary. Size -013 Urethane

Check marker pressure using on screen pressure readout and keep it below 200psi

Remove ASA/Regulator and check O-ring located between grip frame and ASA/Regulator. Replace is necessary.
Size -008 Buna

ASA/REGULATOR ISSUES

There is a leak coming from the bottom of the
ASA/Regulator in the on/off lever area.

My ASA/regulator does not always instantly de-
pressurize when | turn the lever off

Replace O-ring around tank depression pin. Size -006 Buna

Use 3-4 drops of paintball marker oil in the ASA/regulator where the tank is screwed in. Apply air to marker and
cycle the marker to work the oil through.

For more advanced regulator issues please co

ntact paintballsolutions.com. Advanced regulator service is recommended only by certified persons.

MARKER FIRING ISSUES

Before trouble shooting ensure marker has been properly cleaned and lubricated and that a fresh, brand name Alkaline or Lithium 9V
battery is being usea

My marker will not turn on when | press the power
button

My marker has low air efficiency/is not getting the
lexpected amount of shot per air fill but there are no
leaks

Change the battery in marker, If battery is new try unplugging battery from marker for at least 2 seconds and re-|
connecting battery.

Ensure front grip frame screw is fully tightened to allow for full connection between main circuit board and fron{
circuit board

[Note - If the marker is connected to you PC via USB the marker may notturnon._ _ _ _ _ _
Check the paint size to the barrel size you are using. Using a smaller Super Freak insert to get a tighter fit will
greatly increase efficiency

Clean and lubricate the Firing Engine (see Maintenance section above)

Check rubber bolt tip and replace if necessary

Check the Dwell setting on the circuit board and decrease it if necessary.

Check O-ring on outside of Air Guide 2nd from the front of the marker (Firing Engine Diagram #1b) and replace if|
necessary. Size -020 Urethane

Check O-ring on inside of Air Guide 2nd from the front of the marker (Firing Engine Diagram #2b) and replace if
necessary. Size -017 Urethane

S YSTEWM

2



www.empirepaintball.com

MARKER LEAKS

M A RKER

TROUBLESHOOTING GUIDE

My marker has inconsistent velocity or inconsistent
cycles but there are no leaks

My marker will not cycle and a puff of air escapes from
the underside of the marker body when the trigger is
pulled but there are no leaks

My marker will not cycle and a puff of air escapes from
the rear of the Firing Engine when the trigger is pulled
and there are no leaks

After my marker sits for a while the first shot has low
velocity or does not fully cycle.

My markers first shot has a higher velocity that the
rest of the shots after my marker is not fired for a little
while

My markers velocity decreases during rapid fire

My marker is chopping paint in the breech

Check the paint size to the barrel size you are using. Using a smaller Super Freak insert to get a tighter fit will
greatly increase consistency

Clean and lubricate the Firing Engine (see Maintenance section above)

Change battery in marker

Check the Dwell setting on the circuit board and increase it if necessary. If you increase your Dwell you may
have to lower the regulator pressure to achieve desired velocity

Check the rubber bolt tip and replace if necessary

Check the O-ring located on outside of the Bolt nearest to the rear of the marker (Firing Engine Diagram #7) and

change if necessary. Size -016 Urethane

Check the O-ring located on inside of the Air Guide 3rd from the front of the marker (Firing Engine Diagram #2c)
and change if necessary. Size -017 Urethane

Check the O-ring located in the threads on the outside of the Back Cap (Firing Engine Diagram #3) and replace if
necessary. Size -019 Buna

Check the O-ring located in the inside of the Back Cap (Firing Engine Diagram #5) and replace if necessary. Size -
017 Urethane
Ele_an_a;imb_m;te_th_e ang Englne (see Malntenance sectlon above)
Change battery in marker

Check the Dwell setting on the circuit board and increase it if necessary.

Check the O-ring located on outside of Air Guide 3rd from the front of the marker (Firing Engine Diagram #1c)
and replace if necessary. Size -020 Urethane

Check the O-ring located on inside of Air Guide 3rd from the front of the marker (Firing Engine Diagram #2c) and
replace if necessary. Slze 017 Urethane

Clean and Iubncate the Flrlng Engme (see Ma;t;w;c_e ;cgo:eEoTe)_ TTTTTTTmTT T
Change battery in marker

Check the O-ring on outside of Back Cap (Firing Engine Diagram #4) and change if necessary. Size -020 Urethane

Check the O-ring on inside of Back Cap (Firing Engine Diagram #5) and change if necessary. Size -017 Urethane

This is known as Bolt Stick or First Shot Drop Off (FSDO)

Clean and lubricate the Firing Engine (see Maintenance section above)

Change battery in marker

Increase the Anti-Bolt Stick Dwell and possibly decrease the Anti-Bolt Stick Time settings on the circuit board to
m|n|m|ze thIS effect |f it |s notc corrected from Iubrlcatlng the flnng englne

[Check the Anti-Boit Stick Dwell settlng g and decrease it or set it to 0 to turn Fo_ffc_or:pﬁtely_ Tt
Check the regulator pressure by using the on screen read out and watch to see if the pressure is increasing
significantly. If the pressure rises consistently for more than 1 minute your regulator may need to be serviced.

|Contact PaintballSolutions.com ___ _
Clean and lubricate the Firing Engine (see Malntenance sectlon above)

Change battery in marker

Apply 3-5 drops of paintball marker oil in the ASA/Regulator where the tank is screwed in. Apply air to the

marker and cycle the marker 20-50 times to allow oil to work.

Check the regulator pressure during rapid fire by using the on screen read out. If the pressure is not recharging
fully during rapid fire your regulator may need to be serviced. Contact PaintbalSolutions.com

Check and cIean the eyes (See general maintenance section for directions on accessing eyes).
Check rubber bolt tip and replace if necessary
Check the rubber ball detents in the breech. If either is broken or worn replace them.
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Diagram#| SKU

Diagram#| SKU |

FEEDNECK
6
7
8
9
10
11
12

72571
72573
72572
72489
72570
72497
72496

Part Description

Part Description

FEEDNECK LEVER - DUST BLACK (16950)
FEEDNECK LEVER BUSHING

FEEDNECK - POLISHED BLACK (16950)
O-RING BUNA-N 70 DUR -006 (.114 ID)
FEEDNECK THUMB SCREW

SCREW BHCS 8-32 X 1.000

SCREW BHCS 8-32 X .750
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Diagram#| SKU |

FIRING ENGINE
13
14
15
16
17
18
19
20
21
22
23
24
25
26

72556
72558
72567
72564
72565
72552
72568
72553
72549
72557
72566
72563
72555
72569

Part Description

O-RING URETHANE 70 DUR -017 (.676ID)
O-RING URETHANE 70 DUR -020 (.864 ID)
AIR GUIDE

BOLT SPRING

VALVE RUBBER TIP

O-RING URETHANE 70 DUR -013 (.426 ID)
ROD

O-RING URETHANE 70 DUR -014 (.489 ID)
O-RING BUNA-N 90 DUR -015 (.551 ID)
O-RING BUNA-N 70 DUR -019 (.801 ID)
BACK CAP - POLISH BLACK (16950)
DOWEL PIN .125 DIA X .4375

O-RING URETHANE 70 DUR -016 (.614 ID)
BOLT

Diagram#l SKU |

BODY
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42

58

72574
72577
72579
72515
72581
72583
72510
72576
72562
72551
72517
72578
72580
72582
72559
72575
72587

Part Description

HARNESS BOARD EYES RH

BALL DETENT RUBBER CONE

COVER EYE RH - POLISH BLACK (16950}
SCREW BHCS 8-32 X .250

EYE BOARD RH

BODY - DUST BLACK (16950)

SCREW SHSS 3/16 DIA 3/4 LG 8-32 X .250
SCREW SET 10-32 X .250 CP

SOLENOID

O-RING BUNA-N 70 DUR -011 (.301 ID)
SCREW SHCS 5-40 X .250

MAIN CIRCUITBOARD

COVER EYE LH - POLISH BLACK (16950)
EYE BOARD LH

O-RING BUNA-N 70 DUR 1MM CS X 5MM ID
HARNESS BOARD EYES RH

HARNESS BATTERY

www.empirepaintball.com
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GRIP FRAME
30 72515
37 72517
51 72511
53 72588
54 72584
55 72585
56 72590
57 72584
59 72589
60 72516
61 72586
62 72550

TRIGGER
34 72592
49 72591
50 72594
52 72593

M A RKER S YSTEWM

Part Description

SCREW BHCS 8-32 X .250
SCREW SHCS 5-40 X .250

SCREW SHSS 3/16 DIA 3/8 LG 8-32 X .250

GRIP FRAME - DUST BLACK (16950)

MAGNET 8MM DIA X 4MM

BEARING BALL 1/8 DIA

BLOCK RELEASE

SPRING COM .1200D X 0.50FL .020WD RATE 18.LB/IN
BUTTON RELEASE

SCREW SHCS 5-40 X .438

GRIP - BLACK/GREY (16950)

O-RING BUNA-N 70 DUR -008 (.176 ID)

SCREW SET 10-32 X .250 CP

SPRING COM .1840D X .250FL .010WD RATE 0.78LB/IN
TRIGGER - POLISH BLACK (16950)

BEARING

www.empirepaintball.com
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FOREGRIP
43 72514
44 72620
45 72618
46 72619
47 72617
48 72616

Part Description

SCREW BHCS 8-32 X .375

FOREGRIP CIRCUITBOARD
FOREGRIP LH - BLACK/GREY (16950)
FOREGRIP RH - BLACK/GREY (16950)
SCREEN COVER

BUTTON OLED
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Diagram # | SKU

REGULATOR
9
34
51
63
64
65
66
67
68
69
70
71
72
74
75
76
77
78
79
80
81
82
83
84
85
86
87

72489
72513
72512
72615
72609
40916
72610
72604
72605
72597
72614
72613
72601
72598
72599
72490
72651
72509
72602
72612
72606
72607
72611
72608
72595
72596
17597

EMPIRE M A RKER S YSTEWM

Part Description

O-RING BUNA-N 70 DUR -006 (.114 ID)
SCREW SET 10-32 X .250 CP

SCREW SHSS 3/16 DIA 3/8 LG 8-32 X .250
HP REGULATOR CAP - DUST BLACK (16950)
REGULATOR DISK

O-RING BUNA-N 70 DUR -017 (.676 ID)
REGULATOR COVER PLATE

REGULATOR OPP SPRING

REGULATOR SEAL RUBBER

WEDGE RETURN SPRING

PIN WEDGE

REGULATOR LEVER

REGULATOR PIN

ON/OFF PIN

REGULATOR NUT

O-RING URETHANE 70 DUR -012 (.364 ID)
REGULATOR SEAL RETAINER

O-RING BUNA-N 70 DUR 1.5MM CS X 6.5MM ID
PISTON WASHER

HP REGULATOR BODY - DUST BLACK (16950)
REGULATOR SEAL HOUSING

PISTON RETURN SPRING

PISTON

MAIN REGULATOR SPRING

REGULATOR FILTER CAP

REGULATOR FILTER

REGULATOR OPP (COMPLETE)
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Empire Paintball

11723 Lime Kiln Rd.

Neosho, MO 64850

www.empirepaintball.com

Empire Paintball is a brand of KEE Action Sports, LLC.

PATENT(S): See www.paintballsolutions.com/patents © 2012-2013 KEE Action Sports. All
rights reserved. This KEE Action Sports product is protected by one or more United States
patents. KEE Action Sports Trademarks, Designs and Copyrights are protected by one or
more United States patents and International Law. For more information contact KEE Action
Sports at info@keeactionsports.com

LIMITED LIFETIME WARRANTY INFORMATION (ORIGINAL PURCHASE RECEIPT
REQUIRED)

KEE Action Sports (“KEE”) warrants that this product is free from defects in materials and
workmanship for as long as it is owned by the original purchaser, subject to the terms and
conditions set forth below. KEE Action Sports will repair or replace with the same or equiva-
lent model, without charge, any of its products that have failed in normal use because of a
defect in material or workmanship.

KEE Action Sports is dedicated to providing you with products of the highest quality and the
industry’s best product support available for satisfactory play.

Purchaser should register product to activate warranty. Register your product by:

1. Online at www.paintballsolutions.com

2. Complete the product registration card (if applicable) and mail along with a copy of your
receipt to Paintball Solutions, 11723 Lime Kiln Rd., Neosho, MO 64850.

USA 800-220-3222
Canada 866-685-0030
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WHAT THIS WARRANTY DOES NOT COVER

This warranty does not cover problems resulting from abuse, the unauthorized modification
or alteration of our product, problems resulting from the addition of aftermarket products
and scratches or minor superficial imperfections. Due to the nature of paintball products it is
important that the product be maintained by the user as indicated in the product manual to
remain in good operating condition. Your Limited Lifetime Warranty will be void if you fail to
maintain the product as recommended in the product instruction manual. In addition, certain
parts of a product may be subject to wear through regular usage. Replacement and repair of
such parts is the responsibility of the user throughout the life of the product. These parts are
not covered under the Limited Warranty. Examples of this type of part include (but are not lim-
ited to) goggle lens, straps, 0-Ring seals, cup seals, springs, ball détentes, batteries, hoses,
drive belts, gears and any part of a product subject to continuous impact from paintballs.
Hydrotesting of air cylinders is not covered under this warranty.

The Limited Lifetime Warranty also does not cover incidental or consequential damages.

This warranty is the sole written warranty on KEE’s product and limits any implied warranty
to the period that the product is owned by the original purchaser. Some states, provinces
and nations do not allow the limitation of implied warranties or of incidental or consequential
damages, so the above limitations or exclusions may not apply to you. This warranty gives
you specific legal rights and you may also have other rights which vary from state to state,
province to province, nation to nation. If you should encounter any problems with your
product and you have added aftermarket parts on your product, please test it with the original
stock parts before sending it in. Always unload and remove air supply before shipping mark-
ers. Do not ship your air supply tank if it is not completely empty. Shipping a pressurized air
supply tank is unsafe and unlawful. Remove all batteries from products prior to shipping. This
Limited Warranty gives you specific legal rights, and you may also have other rights which
vary from state to state. Some states do not allow the exclusion of incidental or consequential
damages.

For Warranty parts, service, information or manuals in other languages, (where applicable) go
to Paintball Solutions: www.paintballsolutions.com

E-Mail: tech@paintballsolutions.com

US: 1-800-220-3222

Canada: 866-685-0030

11723 Lime Kiln Rd., Neosho, MO 64850

PRINTBRLL

SOLUTIONS
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